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The Supplier provides this publication “as is” without warranty of any 

kind, either express or implied, including, but not limited to the implied 

warranties of merchantability or fitness for a particular purpose. 

 

Information in this publication is subject to change without notice and 

does not represent a commitment on the part of the vender. 

 

Any errors or omissions which may have occurred in this publication 

despite the utmost care taken in its production will be corrected as soon 

as possible, but not necessarily immediately upon detection. 
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System Requirements 

⚫ CPU Pentium 4 2.0GHz above for Windows 10 or above. 

⚫ 2GB of RAM or above for Windows 10 or above. 

⚫ Microsoft .NET Framework 3.5 

⚫ 50MB of available hard drive for the program files 

⚫ CD ROM drive 

⚫ 16bit color display with pixel resolution 1280 x 768 or above. 

⚫ Keyboard, Mouse, and RS232 serial port or USB port 
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Software Installation 

To install AgileCon_2.0 

1. Start Windows and close all unnecessary Windows applications. 

2. Insert the software CD into the CD-ROM drive. The installer user 

interface is displayed. 

3. Click on the “PL2303_DriverInstaller_1181_20170504” to install USB 

driver.  

 

4. Follow the on-screen instruction.  

5. After the installation is completed, click “Finish”. 

6. Click on the “setup.exe” to setup AgileCon_2.0 software 

 

7. Follow the on-screen instruction.  

8. After the installation is completed, click “Finish”. 
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AGILE READER Instrument Setup 

1. Be sure the AGILE READER instrument is in standalone mode.  

Method to switch between standalone and PC modes on AGILE 

READER: 

Turn off the instrument first, then press the “OPTION” key while turn 

on the instrument again, it will switch to other mode.  

2. On AGILE READER standalone mode, please go to SETUP / 

COMPUTER. 

3. Move “UP/DOWN” buttons to select USB port and press “ENTER” to 

confirm selection with mark “S” shown on the right side of that port. 

4. Power off and power on the AGILE READER again, then press the 

“OPTION” key while turn on the instrument, it will switch to PC 

mode. 

5. The instrument starts to do initialization. 

6. After initialized, be sure the screen show “pc_mode” as figure 1 

below.  

 

 

        

 

 

 

 

 

 

Figure 1 
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To Start AgileCon_2.0 

Connect the PC and the instrument with an USB cable, then power 

meter up. Operate your Windows system as the following steps. 

 

1. Press Start menu / Control Panel / Device Manager / Ports (COM & 

LPT) 

2. Find and memorize the “Prolific USB-to-Serial Comm Port” 

number(COM_number). 
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3. Go to AgileCon_2.0. 

From Start menu →All Programs→ACTGene→AgileCon_2.0 

 

 

4. For the first time login, key in default value "admin" for both User 

name and Password in Security window below. Press OK to start 

comport connection. 

User name : admin 

Password : admin 
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5. If PC is successfully connected to AGILE READER, the 

"Connected" sign with green background will appear on the upper 

right message area of the screen. 

 

 

 

6. In case PC cannot connect to the instrument, please press the 

Connect icon to select corresponding COM port as shown in step 2. 

and then press Connect button to confirm selection 

 

 

 

7. Now, the instrument and AgileCon software are ready to perform the 

experiment. 
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AgileCon_2.0 Menu Software Structure 

Main Window Overview 

Section A: Menu 

Section B: Tool bar 

Section C: Message 

Section D: Temperature monitor 

Section E: Working area 

Section F: Data review  

Section G: Special function  
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Section A Menu 

File Menu 

The File Menu contains the file and print functions for the experiment 

data and mapping file.  

 

New: Create a new experiment 

Load (Data or Map): Load a stored experiment, results or map layout 

Save (Data or Map): Save the experiment parameters, results or map 

layout 

Export (.csv): Export report to a file with ".csv" file extension 

Print report: Select experiment to print out 

Preview: Preview experiment report format 

Exit: Close the AgileCon_2.0 software 
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Setup Menu 

The setup menu contains the AgileCon_2.0 system configuration and 

user account management.  

 

 

COM port setting: To set the communication COM port between the 

instrument and PC. 

Filter tune: The AgileCon_2.0 can setup 8 different wavelengths at 

most by inserting the corresponding filters to meter filter wheel. 

Configure the filter wavelengths according to the inserted filters. 

Security setting: To create a new user ID and set up the security level, 

or delete the user ID. 
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Help Menu 

The help menu provides information on software version, contact 

information of the vender, and the user activity records. 

 

 

Audit trail: To record the user activity for trailing. 
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Section B Toolbar 

 

 

 

Connect: To set the COM port to communicate between instrument and 

the PC 

Plate in/out: To open or close the plate compartment 

Shaker: To shake the plate with desired speed and shaking time  

Incubator: To control the incubator with desired temperature, and 

display temperature reading on section D temperature monitor. 

Filter tune: To set up the wavelengths of installed filters on 8-slot filter 

wheel, and have the meter tune the light intensity for each filter. 

Post processing: Use the current protocol to re-process data results 

Start: To start the experiment with current protocol 

 

 

Section C Message 

During operation, the current status will be shown on the upper right of 

the screen. 

 

 

 

Section D Temperature monitor 

When the incubator is activated, the set and actual temperatures are 

shown on the left of the message area. 
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Section E Working area & F Data review 

The AgileCon_2.0 allows you to define measurement protocols and 

analyze obatined microplate data. The protocol parameters are input in 

E Working area, and the test data is shown in F Data review. 

 

Section G Special function 

The special function is customized for the Biotest reagent test. This 

experiment effects only in conjunction with the Biotest reagents. 
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AgileCon_2.0 Function 

Basic Parameters 

Measurement types: The AgileCon_2.0 provides three types of 

measurement, i.e. End point, Two point, and Kinetic measurement.  

 

End point read: During the end point read, the AGILE READER reads 

at one wavelength, with one-reference wavelength read as optional 

 

Two points read: During the two points read, the AGILE READER 

reads at two wavelengths, with two-reference wavelength read as 
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optional.  

 

Kinetics read: During the kinetics read, users can define the kinetic 

method by selecting Average rate, Maximum rate, Maximum Abs, Total 

delta Abs, Time to max rate, or Time to max Abs in the Kinetic method  

 

list. The user can also define the measure numbers and interval. 

 

To Set up a measurement with End point, Two points or Kinetic method, 

user need to define following parameters. 

 

Primary and Reference wavelengths 

If a Primary wavelength is defined alone, the AGILE READER reads the 

plate only once at a single wavelength. If a Reference wavelength is 

defined, the plate will be read twice and automatically calculate the delta 

Abs between these two readings.  

Method to set up the Primary and Reference wavelengths: 

1. Select the Measurement type of End Point, or Two Points. 

2. Enter the Primary wavelength in Main1 or Main2, and the reference 

Ref1 or Ref2 

 

Starting method to read plates 

If the "Immediate" option is selected, the instrument starts reading the 

plate right after the Start button is pressed. Users can also define the 
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period of the plate reading delay.  

To define the starting method, 

1. Select the "Immediate" option.  

2. Or choose “Delay”, then input the delay time in second.  

 

Plate motion 

Users can select the plate motion as stepping in milliseconds or 

continuous mode.  

 

The built-in Incubator 

The incubator will keep the plate stay at temperature-controlled 

environment. 

Users can activate the incubator by 

1. Clicking the incubator button on toolbar to display the incubator 

pop-up menu. 

2. Entering the desired temperature on the pop-up menu, and press 

“Activate” tab to start the temperature control.   

 

The built-in Shaker 

The built-in Shaker in the instrument allow user to define speed setting 

as Low 8Hz, Medium 11Hz, or High 14Hz. Users can also define the 

shaking period.  

To enable the shaker, 

1. Click the shaker button 

2. Select the speed to be Low, Medium or High 

3. Define the shaking period in second.  
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Well Mapping 

Users can define five types of different wells. They are Blank, Standard, 

Sample, Positive, and Negative on the Type menu at Map layout.  
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Quantitative / Cut off / Ratio / Inhibition / QC 

Quantitative setting 

 

The AgileCon_2.0 allows user to define quantitative analysis to 

determine the sample concentration. Seven types of curve fitting 

equations are built to calculate standard polynomial coefficients. Users 

can select Curve on plate, Stored curve, Standard line, or Concentration 

factor to define Quantitative method. 

 

1. Click the Quantitative / Cut off / Ratio / Inhibition / QC button. 

2. Click the check mark in front of the Quantitative settings area, and 

be sure the check mark turned into green.  

3. Define the desired parameters. 
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Cutoffs 

 

Cutoffs are used to classify results. Users can define three Cutoff 

methods as Single, Double or Calculation.   

1. Click the Quantitative / Cut off / Ratio / Inhibition / QC button. 

2. Click the check mark in front of the Cutoff settings area, and be sure 

the check mark turned to green. 

3. Define the desired parameters. 
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Ratio/Inhibition 

 

The AgileCon_2.0 will take a reference (B0) and other samples (B) to 

calculate the Ratio/Inhibition  

1. Click the Quantitative / Cut off / Ratio / Inhibition / QC button. 

2. Click the check mark in form of the Ratio/Inhibition settings area, and 

be sure the check mark turned green. 

3. Define the desired parameters. 
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Q.C. 

 

The AgileCon_2.0 provides Q.C. algorithm for experiment to determine 

the results.  

 

1. Click the Quantitative / Cut off / Ratio / Inhibition / QC button. 

2. Click the check mark in front of the Q.C. settings area, and be sure 

the check mark turned green. 

3. Define the desired parameters. 
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Print options 

 

Users can define the Project title, User name, experiment Note, and 

check the desired items in Sections for printing to print the result of the  

experiment.  
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Main Menu Configuration 

 

There are three functions on the main menu. They are File, Setup and 

Help. 
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File menu functions 

 

There are seven options, i.e. New, Load (Data or Map), Save (Data or 

Map), Export (.csv), Print, Preview, and Exit under the main menu. 

1. New: Create a new experiment 

2. Load (Data or Map) : Load an existing experiment file or map layout 
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3. Save (Data or Map) : Save experiment file or map layout 
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4. Export (.csv) : To export to a file with file extension "csv", and it can 

be loaded into the excel, notepad or google spreadsheet 

5. Print: To print report using the printer connected to the PC 

6. Preview: To preview the experiment report before printing 

 
 

7. Exit: to end the AgileCon_2.0 operation 
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 Setup menu functions 

 

The setup menu includes COM port setting, filter tune, and the Security 

setting.  

 

1. COM port setting: User can change the desired COM port to 

communicate between instrument and AgileCon_2.0. The 

AgileCon_2.0 can automatically detect all available COM ports on 

the PC. 

 

2. Filter tune: The instrument has an eight- slot filter wheel for user to 

install filters. After installing new filters on the instrument, it is 

important to set the correct filter wavelength on the AgileCon_2.0. 

Check the check box on the left to enter desired wavelength for the  

 

filter, and press the Tune button after the desired wavelengths are 

entered. 
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3. Security setting: Users should log in with their own ID and Password 

to start the experiment. This function lets you log in / log out system, 

create, and or delete user ID. 

 

 

To enter the system, please use the default value (admin) to log in. 

 

User name: admin 

Password: admin 

 

Entering the wrong user name or password, The AgileCon_2.0 will 

show the pop-up window as below. 
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   Log out system  

 

 

 

Create a new ID 

This function can be performed by users with administrator authority 

only. 
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Enter the new ID with user name, password, and ID authority 

(administrator or user), and then press Save button to accept.  

 

 

 

Successfully creating a new user will see the pop-up window as below. 
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Delete ID 

This function can be performed by users with administrator authority 

only. 

 

 

 

 

Enter the ID which you want to delete and press Delete to execute. 
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Help menu functions 

 

The help menu is trails the log-in and operation record. 

 

1. Audit trail: To review the records of activities of different ID 
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Toolbar Menu Configuration 

 

There are Connect, Plate In/Out, Shaker, Incubator, Filter tune, and 

Post processing tabs on the toolbar menu. 

 

1. Connect: To setup the COM port connection between the instrument 

and the PC. 

 

2. Plate in/out: To move the plate holder in or out, the plate holder 

status will show on the status bar 

 

 

3. Shaker: This tab is used to configure and operate the shaker. The 

shaker has three translation speeds, i.e. low (8Hz), Medium(11Hz) 

and High (14Hz) 

 

4. Incubator: To warm up the incubator at set-point temperature from 

the lowest 15℃ to the highest 50℃. If the ambient temperature is 

higher than 15℃, the effective lowest temperature should be set to 

the ambient temperature + 3C. 

 

 

5. Filter tune: The AgileCon has an eight- slot filter wheel for user to 

install filters 
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6. Post Processing: Use the current parameters of selected measure 

mode and recalculate the data  
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Message Area Configuration 

 

The message area contains two parts, the status message and the 

temperature monitor. 

 

1. Status message: To display the status of instrument current 

operation condition. All messages are listed in the following chart.  

 

Message  Description 

Initializing Initializes the instrument 

Standby Test ready 

Data reading Load data 

Post processing Recalculate the data 

Disconnect The instrument has no connection with AgileCon_2.0  

Connected The instrument connects with AgileCon_2.0 

Filter tune Start tuning filter 

 

2. Temperature monitor: To display the real-time temperature and 

set-point temperature of instrument incubator.  
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Defining Parameters for Experiment 

Defining Parameters  

When starting an experiment, users must first define the parameters 

such as wavelength, reading method, plate motion, incubator, and 

shaking. Above functions are included in Basic parameters tab.  

 

1. Measurement Type: Users can define three measuring types, i.e. 

End point, Two point and Kinetic. 

 

a、 End Point 
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b、 Two Points  

 

 

c、 Kinetics: Kinetics measuring method can only select main filter 

without reference filter 

 

2. Filter wavelength: Users need to select the main filter wavelength for 

the desired experiment. In addition, users can also select a 

reference wavelength.  

 

3. Starting method: Define when to start the selected experiment. 

a、 Immediate: Start measurement right after pressing the START 

tab 

b、 Delay: Users can define 0~999s as delay time before starting 

measurement. 
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4. Plate motion: To define how the plate is moved when measuring 

a、 Continuous: When measuring, the plate is translated smoothly 

during the entire motion stroke. 

 

b、 Stepping: User can define the stepping intervals among 0~999 

msec. In kinetic mode, there are variable stepping interval and 

fixed stepping interval to be selected.  

 

 

 

5. Incubation: Users can define the incubator temperature by clicking 

the incubation tab. The temperature can be set from ambient  15℃ 

to  50℃.  
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6. Shaker: The shaker of the instrument shakes with three types of 

speed, and the shaking time can be arranged among 0~999s 

 

7. Two point interval: Users can select the two point interval among 

3~999s 

 

 

8. Kinetic method, numbers, and interval: In kinetic measurement 

mode, user can select the data calculation method, test cycles, and 

cycle interval.  

a、 Kinetic method: Uses can select Average rate, Maximum rate, 

Maximum OD, Total delta OD, Time to max slope, Time to max 

OD for mapped wells calculation.  
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b、 Measure number: User can enter the measuring numbers 

among 3~255 cycles. 

c、 Measure interval: User can enter the measure interval. They 

are among 4~65535s in continuous motion, and 6~65535s in 

stepping motion. 
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Well Mapping 

The AgileCon_2.0 provides five types of well for the user to define 

96-well map. Moreover, the user can save the mapped wells and reload 

them for further uses.  

 

1. Save and load map layout:  

Users can load or save their map layout from File/ Load (Data or 

Map) or Save (Data or Map) functions 

 

 

 

 

 

 

 

 

 

 

 

2. Well mapping method:  

a、 Select the well type to be defined (Blank, Positive, Negative, 

Sample, Standard) on the map layout. On the right side, enter 

the concentration values if standard is selected.  

 

Note: Sample is the only available type in kinetic mode. 
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b、 Select the fill and replicate directions, enter next fill number, 

and replicate number. 

 

 

 

c、 Use mouse to draw an area, which wells are to be placed with 

selected type. 

d、 Right click on the mouse to select the fill option. 

 

 

e、 The selected ten standards are thus located on the well map. 
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3. Fill and replicate well: 

a、 Fill direction: To number the sequence of selected sample type 

in column or raw direction. 

b、 Replicate direction: To number the sequence of the replicates 

of selected sample type in column or raw direction. 

 

 

Example of filling and replicating the well map 

 

 

 

 

 

 

 

4. Blank, positive control, and negative control each has only one 

name (BLK01, POS01, NEG01).  

5. Standard can be configured as 1~15 names(STD01~STD15) 

6. Sample has 96 names most (SAM01~SAM96). 
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7. Types of well:  

a、 BLK: Which is painted with light green background on the well 

map 

b、 POS: Which is painted with light red background on the well 

map 

c、 NEG: Which is painted with light blue background on the well 

map 

d、 Sample: Which is painted with light orange background on the 

well map 

e、 Standard: Which is painted with light purple background on the 

well map  

Users must fill in the concentration values of selected 

standards in ascending or descending order. 

 

 

 



47 

 

Quantitative Measuring Method 

The AgileCon_2.0 provides four types of Quantitative method, i.e. Curve 

on plate, Stored curve, Standard line, and Concentration factor.  

 

1. Curve on plate: Use the standard on the well plate for the calibration 

curve calculation. There are seven types of curve fitting equations 

on the AgileCon_2.0 

a、 Linear regression 

b、 Quadratic polynomial 

c、 Cubic polynomial 

d、 Point to point 

e、 Cubic spline 

f、 2 parameters logit-log 

g、 4 parameters logistic 

h、 Advance BIO (Option function)  
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2. Stored curve: Users can load their stored curve for quantitative 

measurement, these curves with file extension ".cuv" are stored 

under directory AgileCon 2.0\StdCurve.  

 

 

 

 

 

3. Standard line: User can use the Abs=A* Conc+B equation, and enter 

the values of A and B to calculate a standard line. 

 

The value of A can be：-999999.999 ~ +999999.999 

The value of B can be：-999999.999 ~ +999999.999 
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4. Concentration factor: User can enter a factor for calculating the 

concentration. 

The value of F can be：-999999.999 ~ +999999.999 

 

 

 

5. Measurement unit: Users can select 15 types of measurement unit 

"None" ,  "G/dL" ,  "U/L" ,  "G/L" , "ug/dL" ,  "ABS" ,  "mg/dL" ,  

"OD" ,  "mABS" ,  "U/mL" , "ug/mL" , "mEq/L" ,  "mmol/L" , 

"umol/L" , "ng/mL". When “None” is selected, user can enter the 

desired measurement unit 
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Cutoff Measuring Method 

The AgileCon_2.0 provides three types of Cutoff measuring method.  

 

1. Single cutoff method: User can enter a threshold of 0.0000~4.0000, 

and define OD result to be positive or negative.  

 

 

2. Double cutoff method: Users can define the high and low thresholds. 

The high and low values can be among 0.0000~4.0000. The 

AgileCon_2.0 determines OD results that are higher than high 

threshold, lower than low threshold, or between low and high 

thresholds to be positive(+), negative(-), or in-between (*) 

respectively. 

 

 



51 

 

 

3. Calculation cutoff method: User can create a maximum of four 

formulas as the thresholds calculation and categorize the OD 

readings into 5 groups.  

 

The equation listed below is applied to construct the thresholds with 

given a, b and c values. 

EQn = a * PC + b * NC + c,  

 

where PC means Positive Control, and NC means Negative Control. 

The value of a, b and c can be -1000.000 ~ +1000.000 

 

The calculated threshold values must follow the rule below: 

EQ1 > EQ2 > EQ3 > EQ4 

 

Example: With four thresholds applied, the OD reading higher than 

EQ1, between EQ1 and EQ2, between EQ2 and EQ3, between EQ3 

and EQ4,or below EQ 4 is labeled by "++", "+", "＊", "-" or "--" 

respectively. 
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Ratio/Inhibition Calculation Method 

Select B0 as the standard value to calculate the rest of the plate well Bn  

 

1. Ratio/Inhibition operating procedure 

a、 Ratio = (Bn/B0)% 

b、 Inhibition = 100% - (Bn/B0)% 

c、 Must have sample on B0 position or the AgileCon_2.0 will 

show error  

d、 If the selected Bo has replicate number greater than one, the 

actual B0 value will be the average reading of this sample. 

e、 If B0 value is 0, the AgileCon_2.0 will show error 

f、 If ratio is over 200%, the AgileCon_2.0 will show HI; if lower 

than -200%, the AgileCon_2.0 will show LO 
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Q.C. Calculation Method 

The purpose of the QC Calculation Method is to determine the reliability 

of the experiment.  

    

1. At most 4 equations are applied to obtain the calculation results, 

QC1, QC2, QC3 and QC4.  

2. Combining above QCs with logic operators OR, AND, and XOR to 

obtain the QC calculation result. The truth or falseness of QC 

decides the experiment to be pass or fail. 

3. The value of a can be -1000.000 ~ +1000.000 

4. The value of b can be -1000.000 ~ +1000.000 

5. The value of c can be 1000.000 ~ +1000.000 

6. The value of H can be -9999999.999 ~ +9999999.999 

7. The value of L can be -9999999.999 ~ +9999999.999 
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Printing Options 

Users can input project name, operator name, and experiment note to 

differentiate experiment reports. Users can also check boxes in the 

Section for printing to determine which items need be printed on the 

report. 
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Interpreting the Results 

The AgileCon_2.0 will generate the result data after the experiment is 

completed. Press the Data tab on the left window, and select tab 

Results, Calibration, Data, Cutoff, Ratio/ Inhibition, Q.C, or Kinetic to 

view their experiment results. 

 

1. Results: Click on the Results tab to review the parameter setup, 

plate layout, Raw OD, and Con Matrix of the experiment.  

 

 

2. Calibration: When Quantitative is checked, calibration curve will be 

displayed according to the setting parameters.  

a、 Layout: Shows the well mapping layout of the plate. Different 

types of well uses a different color to represent.   

b、 Source data: Shows the source data for the quantitative 

measurement.  

i. In end point measurement, if there is no reference filter 

then the main filter (M1) data is the source data. If there is 

reference filter then M1 – R1 is the source data.  

ii. In Two points measurement if there is no reference filter, 

the source data will be M1 

iii. In Two points measurement if there is reference filter then 

the source data will be D1=M1-R1 

iv. During Kinetic measurement, user cannot use reference 

filter, the M1 data will be the source data 

c、 Calibrators: Use C01~C15 to represent each STD’s name and 
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OD value, and show the average measurement and the 

standard concentration value. 

d、 Calib Curve: When using standard curve (Curve on plate or 

stored curve), apply selected fitting method to create a 

standard curve and its coefficients.  

e、 Residuals table: Use C01~C15 to show standard concentration 

values (C set), Average Abs, calculated concentration (Ccal), 

and their difference (Ccal-Cset). 

f、 Curve Viewer: User can double click on the curve to enable the 

curve viewer. User can also store the curve by pressing the 

Save Curve tab on the right. The default curve is stored in 

AgileCon_2.0\StdCurve directory. 
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3. Data sheet: The raw data and calculated results of entire mapped 

wells can be listed in one data sheet. The sheet provides information 

about Name, Well ID, Replicate numbers, Abs, SD, CV%, Conc, 

Measuring unit, Cutoff, and Inhibition %. The average of replicated 

data is displayed by "_avg" next to the well ID.  

 

4. Cutoff results: Clicking the Cutoff tab, the AgileCon_2.0 shows the 

cutoff symbols on mapped wells. Depending on the conditions, there 

will be five symbols to represent the cutoff results. 

﹝++﹞、﹝+﹞、﹝*﹞、﹝–﹞、﹝－－﹞ 
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5. Ratio/Inhibition results: Clicking the Ratio/Inhibition tab, the 

AgileCon_2.0 shows ratio or inhibition values of mapped wells. Data 

higher than 200% is shown Hi, and lower than -200% is shown LO. 

 

 

6. Q.C results: Clicking the QC calculation method, the AgileCon_2.0 

shows the QC criteria, Pass condition, and Result on the data sheet. 
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7. Kinetic results: When using the kinetic measuring method, 

AgileCon_2.0 will display the kinetic curves for each mapped wells. 

User can check the reaction rate easily on this screen.  

 

 

Double click on the selected well to show a detailed view of the well 

number and OD value at selected sampling number.  

 

 

 

 


